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Installation

Note: if you have previously installed a version of the FM 4/100 software earlier than 
3.5, you must uninstall it before installing this version.

After downloading and double-clicking the Install_FM 4-100_3.5.dmg file, you should 
see the following window:

Drag the icon labeled FM 4-100 USB Software over the icon labeled Applications 
alias then release the mouse. This will cause the Finder to copy the FM 4/100 software 
to your Applications folder.
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Once the copy is complete, open the /Applications/FM 4-100 USB Software/ 
folder and double-click on the FM 4-100 USB application.

If this is the first time you are installing this software, or if you are installing a newer ver-
sion, an installation dialog will appear. Click on Continue to finish the installation, or 
Cancel if you want to finish it the next time you run the FM 4-100 USB application. The 
installation must be completed before the FM 4/100 software will be fully functional.
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Once all the software components have been installed, click on the Finish button. A 
connection will be established between the FM 4/100 software and the FM 4/100 hard-
ware, and you can start working with the software.

Uninstalling

To uninstall run the FM 4-100 USB uninstaller located in the /Applications folder. 
Click on the Uninstall button to begin. When the uninstall is finished, click on the Quit 
button.

If there are multiple user accounts on this Mac, there may be multiple installations of the 
FM 4/100 software, one for each user. Each user shares the FM 4-100 USB application 
and the FM 4-100 USB uninstaller, but other software components are installed sepa-
rately for each user account. For this reason, the uninstaller does not remove itself or 
the FM 4-100 USB Software folder. Before deleting either of these, please make sure 
that the software has been uninstalled from all user accounts.

After uninstalling, you may notice that the FM 4/100 driver still appears in the Audio/
MIDI Setup ( /Applications/Utilities/ ) MIDI window. This is because the Mac 
OS X tries to remember the state of your MIDI setup, even if there are changes such as 
removing or powering down equipment or removing drivers.
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Although the driver has no effect at this point, you can remove it from Audio/MIDI 
Setup if you wish. To remove the driver, disconnect the FM 4/100 from the Mac and wait 
for the driver’s icon in Audio/MIDI Setup to be dimmed as in the graphic below.

Click on the FM 4/100 USB icon to select it, then hit the DELETE key on the Mac key-
board or choose Delete from the Edit menu. Quit Audio/MIDI Setup.

The FM 4/100 software’s preference file is not removed by the uninstaller. It takes up 
relatively little space and should have no impact on the operation of other software once 
the FM 4/100 software is uninstalled. If you want to remove it, just delete the file 
~/Library/Preferences/com.jlcooper.FM4100USB.plist.
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System Setup

The FM 4/100 software relies on Apple’s Universal Access to perform mouse emulation. 
In order for the FM 4/100 software to work correctly, you must open System Prefer-
ences and go to the Universal Access pane. Make sure “Enable access for assistive 
devices” is checked then quit System Preferences.

FM 4/100 USB Software for OS X
5



Introduction

The FaderMaster has four physical faders and four physical channel buttons but actu-
ally has 16 channels internally. You can switch between four banks of 4 channels with 
the Inc/Dec buttons. There is one button per channel, but each button's function can be 
changed by pressing the SELECT, AUX, SOLO or MUTE button. So even though there 
are only two physical controls per channel, there are six functions (counting the Touch 
Sensors which are activated every time a fader is touched or released).

The FM 4/100 Software extends the FM 4/100 hardware’s ability to control various ap-
plications running on your Macintosh™. It does this by communicating with applications 
via MIDI, USB and other messaging protocols built into the Mac OS. It can also simulate 
mouse clicking and dragging, keystrokes and can even emulate other control surfaces if 
necessary.

Keysets

The FaderMaster software uses "keysets" which are sets of various actions that are 
taken when FaderMaster controls are pressed or moved. Different keysets can be ap-
plied to different applications, and the FaderMaster software will choose the correct 
keyset for whichever application is in the foreground. If no keyset has been created for 
the current foreground application, the FaderMaster will use a built in keyset called the 
"Default" keyset.

To create or edit FaderMaster keysets, open the application, "FM 4-100 USB" 
(/Applications/FM 4-100 USB Software/). To create a new keyset, choose 
New Keyset from the File menu and navigate to the application that will use the new 
keyset. You can also use Import Keyset from the File menu to get an existing keyset. 
You only need to use New Keyset or Import Keyset once for a given application. After 
that, keysets are stored with the FaderMaster's preferences.

You can use Export Keyset from the File menu to save a copy of a keyset so it can be 
transported to another Mac or archived for safekeeping. You don't need to use Export 
Keyset in your daily use of the FaderMaster. Your changes are added to the FaderMas-
ter preferences file automatically.

This package includes keysets for Final Cut Pro™, Logic Pro™ and Nuendo™.
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Editing Keysets

The application presents a graphical representation of the FM 4/100 front panel. When 
you click on an on-screen control (or move a control on the FM 4/100 itself), that control 
is selected and information about it appears in the floating Inspector window.

You can choose which keyset to edit within the FM 4/100 USB application using the 
Keysets menu. The menu lists all keysets that you have created or imported. The name 
of the currently selected keyset will be displayed at the bottom of the main window.
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The FM 4/100 application displays all six functions for all sixteen channels as if they 
were actual hardware controls.
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To choose which control's actions to edit to edit:

1.! Click on the picture of an on-screen control with the mouse.
! ! or
2.! Press or move a control on the FM 4/100 hardware.

The selected control will be highlighted. NOTE: the faders do not move on-screen. The 
selected fader will be highlighted as in the graphic below:

Information about what action is assigned to the selected control appears in the Inspec-
tor window.
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The Inspector Window

The Inspector window is where all your work takes place. It displays information about 
the currently selected control and contains the facilities for editing that information.

The Name text box allows you to give a control a more descriptive name that describes 
its precise function. In the example above, the “Select 9” button has been assigned an 
action that rewinds from the current time indicator, so naming the button “Rewind” con-
veys more information than “Select 9”.

If the selected control is a button, then immediately below the Name you will see a 
“Latched” checkbox that lets you choose between a momentary (pressing the button 
turns it “on”, releasing it turns it “off”) or latched (pressing and releasing it turns it “on” 
and pressing and releasing it a second time turns it “off”) behavior.
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Next is a description of the action that is to take place when the selected FM 4/100 con-
trol is pressed or turned while the target application is active.

Below that is the area where this action can be edited. There are a series of tabs repre-
senting the different kinds of actions that can be performed. Clicking on one of these 
tabs will display controls for editing its kind of action. The available actions vary depend-
ing on the type of control being edited, but can include Built In, Keystrokes, Mouse, 
MIDI, Emulation and Special.

Any changes made in one of these tabs are immediately applied to the selected control. 
The FM 4/100 software allows multiple levels of Undo, so you can easily get back to any  
starting point.

Also at the bottom of the Inspector window is the Delete Action button. When pressed 
it will delete the action currently assigned to the selected control. This is also undoable.
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Action Tabs

Keystrokes Tab

The FM 4/100 Mute, Solo, Aux and Select buttons can be assigned to send a sequence 
of keystrokes to an application just as if they were keys on the Mac keyboard. These 
assignments are set up in the Keystrokes Tab.

Select a control to edit, place the cursor in the Keystroke field and type a key. If you 
hold down any modifier keys (command, shift, option or control) while typing this key, 
the modifier checkboxes will be set up accordingly. You can also manually change the 
modifier checkboxes by clicking on them.
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Some key/modifier combinations may be intercepted by the operating system before 
they reach the Inspector window. If this happens, just type the key without any modifi-
ers, then click on the appropriate checkboxes to add the desired modifiers.

To add more keystrokes to the sequence, click on the Next button and repeat the above 
procedure. You can move forwards or backwards in the sequence with the Next and 
Previous buttons. The Delete Keystroke button will remove the currently displayed 
keystroke from the sequence.

If Repeat while pressed is checked, the keystroke (or sequence) will repeat as long as 
the FM 4/100 control is held down. The speed of the repeat is controlled by the Repeat/
Typing Speed slider. This slider also determines how much time there is between key-
strokes if the sequence is more than one keystroke.

If the key sequence in the example below was assigned to the STOP button, pressing 
and holding STOP would be the equivalent of repeatedly typing the word “Mute” until 
STOP was released.
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Mouse Tab

The buttons on the FM 4/100 can be made to emulate Macintosh mouse clicks.
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The Mouse Action popup lists the available actions.

The Starting Location popup lets you choose where on the screen the click will take 
place.

If you choose Don’t Capture, the click will always be performed at the current location 
of the Mouse pointer. If you choose any other option, you will be prompted to pick a 
point in one of the target application’s windows. The options in this menu determine how 
the FM 4/100 will find that point in the event that the destination window has been re-
sized or moved.

Option When Destination Window is Re-
sized or Moved

Relative to Window Top Left The start point will stay the same 
distance from the top left corner of 
the window.

Relative to Window Top Right The start point will stay the same 
distance from the top right corner of 
the window.

Relative to Window Top Percentage of Width The start point will stay the same 
distance from the top of the window, 
but it’s horizontal position will be a 
percentage of the window’s width..
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Option When Destination Window is Re-
sized or Moved

Relative to Window Bottom Left The start point will stay the same 
distance from the bottom left corner 
of the window.

Relative to Window Bottom Right The start point will stay the same 
distance from the bottom right cor-
ner of the window.

Relative to Window Bottom Percentage of Width The start point will stay the same 
distance from the bottom of the 
window, but it’s horizontal position 
will be a percentage of the win-
dow’s width..

Relative to Screen Top Left The start point will stay the same 
distance from the top left corner of 
the screen, no matter what the size 
or position of the window.

For example, let’s say that a particular application has an onscreen master solo button 
in the lower right hand corner of it’s Timeline window, and the center of that button is 
100 pixels from the right of the window and 20 pixels from the bottom of the window. 
When the window is resized, the button stays at 100 pixels from the right and 20 pixels 
from the bottom of the window.

Suppose the only way to access this program’s master solo function is by dragging this 
slider left or right. You could program FM 4/100 Solo button to do a mouse click at 100, 
20 Relative to Window Bottom Right.
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Once you have chosen from the Starting Location popup, you will be prompted to ac-
tually pick the click location.

Make Sure the target application is open in the background, and that the destination 
window is visible. Hit the Capture button then position the mouse pointer over the de-
sired starting point and type <COMMAND K>.
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The Inspector window will be updated to show the window name and coordinates 
where the click should take place.

From now on, whenever you are in the target application and use the assigned control, 
it will move the destination window to the front, then click, move or drag at the selected 
location.

Once a window name and mouse location has been captured, you have the option of 
using a partial window name. This is useful in applications like Final Cut Pro, where the 
Canvas Window’s title always starts with the word "Canvas" but the rest of the window 
title changes depending on what you're editing. Normally, the FM 4/100 tries to find a 
window with the exact name as the window where the click was first captured, but if the 
window name has changed, it will fail. If you choose to have the FM 4/100 just look for 
the word Canvas in Final Cut Pro it will always find the Canvas Window, even if the ex-
act name of the Canvas Window changed since the click was captured.

To use the partial name feature, click on the Partial Window Name checkbox. In the 
text box on the right, change the full window name to the partial name you want the FM 
4/100 to use.
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MIDI Tab

The USB version of the FM 4/100 can be made to appear as a MIDI device to MIDI ap-
plications. Any FM 4/100 control can be programmed to send and respond to a MIDI 
message.

There are three radio buttons for choosing the type of MIDI message to assign.

None No MIDI message for the selected control. If some other type of ac-
tion has already been assigned, the None button will be selected. 
Clicking on the None button will delete the currently assigned ac-
tion.

Native MIDI Native MIDI actions send and respond to the same messages as 
the MIDI version of the FM 4/100. You would typically use this set-
ting with an application which directly supports the FM 4/100 proto-
col. It could also be used with an application that has a MIDI “Learn” 
feature.

For convenience, choosing Set all Controls to Native MIDI in the 
Actions menu will assign Native MIDI actions to all of the FM 4/100 
controls on all layers in the current keyset.

Custom MIDI Custom MIDI actions send and respond to user defined MIDI mes-
sages. 
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When Custom MIDI is chosen, more controls will become visible for editing the custom 
messages.

The MIDI Message Type popup lets you choose any of the basic MIDI messages ex-
cept for system exclusive and MIDI Time Code.

The first group of messages in the popup include a MIDI channel. If you choose one of 
these message types, a channel editor appears. You can either type or use the up and 
down arrows to set the channel. This editor accepts values from 1 through 16.
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All MIDI messages except for system exclusive are either one, two or three bytes long. 
The first byte always is the message type, called the status byte. If there is a MIDI 
channel, it is embedded in the status byte. The bytes following the status byte, if any, 
are referred to as data bytes and contain additional information such as note numbers, 
velocities, control values, etc...

If you choose a message type that is more than one byte long the 1st Data Byte ( and 
possibly the 2nd Data Byte) editor appears. You can set the data byte’s value by typing 
or using the up/down arrows. The editor accepts values from 0 through 127.

Instead of setting an absolute value for a data byte, you can check the Follows Con-
trol’s Value box. In this case, the value of that data byte is determined by the state of 
the FM 4/100 hardware control this message is assigned to. In other words, if you as-
signed a Custom MIDI Message to fader and the 2nd data byte was set to Follows 
Control’s Value, a number representing the movement of the fader would be inserted 
as the 2nd data byte of the custom message. For FM 4/100 buttons, a value of 127 will 
be inserted for button presses, and 0 for button releases.

Following are some samples of the MIDI Tab’s appearance for various message types.

To access the FM 4/100’s MIDI messages in your MIDI application, connect your appli-
cation’s MIDI input and output ports to the ports labeled “FM 4/100”. Depending on the 
application, the ports may be labeled “FM 4/100 USB”. The exact method for connecting 
to MIDI ports varies from application to application. Consult the manuals of the MIDI ap-
plications you are using to learn how to do this.
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Emulation Tab

The FM 4/100 software has the ability to emulate other MIDI based control surfaces. 
This feature is useful if you are using the FM 4/100 with a MIDI application which 
doesn’t directly support the FM 4/100, but which supports one of these other control sur-
faces.

You can set any control on the FM 4/100 to emulate a control on one of these control 
surfaces using the Emulation Tab. The Emulation Tab is not available until you turn on 
Emulation in the Emulation Menu. Here you can choose None, Mode A, or Mode B. 
Mode A and B represent two different control surfaces. Which one you choose depends 
on the application you are using with the FM 4/100. More on this later.

The contents of the Emulation Tab varies depending on the type of FM 4/100 control 
that is selected. This is what you will see at first if you select a button.
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The Control Group popup lists the basic categories of controls that can be emulated by 
the selected FM 4/100 control. Checking Emulate this control: or choosing from the 
Control Group popup will assign an Emulation action to the selected control. It will also 
display either a second popup or a numerical editor for choosing which control in the 
group to emulate.

For some control categories, such as Transport, the individual controls in that category 
have names, such as Rewind, Fast Forward, Stop, Play and Record. For these cate-
gories a second popup will list the control names.

For other categories, such as F-Keys, the controls are just numbered. For these cate-
gories a numerical editor will appear. This allows you to either type or use up/down ar-
rows to set the control number.

For convenience, choosing Set all Controls to Emulation in the Actions menu will as-
sign Emulation Actions to many of the FM 4/100 controls in the current keyset. Faders 
1 - 7 are assigned as faders 1 - 7. Fader 8 is assigned the fader 9 function which is the 
master fader. Mutes 1 - 8 are assigned the Mute function, Solos 1 - 8 the Solo function, 
Aux 1 - 8 the Pot Switch function, and Select 1 - 8 the Select function.
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Special Tab

The Special Tab is a collection of actions that don’t easily fit into other categories.

Currently, the choices are:

None No Special Action for the selected control. If some other type of ac-
tion has already been assigned, the None button will be selected. 
Clicking on the None button will delete the currently assigned action.

Developer Mode This is intended for use with applications which directly support the 
FM 4/100. This action uses messaging protocols built into Mac OS 
X to communicate with these applications.

You normally wouldn’t use this mode unless you knew that an appli-
cation you were using supported it. 3rd party developers who support 
this mode would typically ship FM 4/100 keysets along with their 
applications.

For convenience, choosing Set all Controls to Developer Mode in 
the Actions menu will assign Developer Mode Special Actions to 
all of the FM 4/100 controls on all layers in  the current keyset.
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Built In Actions Tab

The built in actions are actions that are predefined for specific applications. When you 
choose a keyset, the built in actions appropriate to that keyset’s application are dis-
played. If no built in actions have been defined for the current application, the display 
will be blank.

The built in actions are presented in two columns. The left hand column lists basic cate-
gories and the right hand column lists the actual actions. Clicking on a category in the 
left hand column will change the list of actions displayed on the right. Double-click an 
action name to assign it to the selected FM 4/100 control.

Most of the categories and actions correspond to the keyboard shortcuts listed in the 
target application's manual. However, there are also actions defined by JLCooper that 
are not simple keyboard shortcuts. These actions will always appear at the beginning of 
the list, and there will be a separator line between them and other built in actions.
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Final Cut Pro™
Final Cut Pro™ versions 5 through 7 have built in support for several MIDI control sur-
faces. Although the FaderMaster 4/100 is not one of the directly supported control sur-
faces, the FM 4/100 software's Emulation Mode A allows it to work with Final Cut.

To use the FaderMaster with FCP 5 or later, first run the FM 4/100 application and im-
port the Final Cut keyset provided by JLCooper (located in /Applications/FM 4-
100 USB Software/keysets). You can also create your own Final Cut keyset follow-
ing the steps described in the section Keysets above. If you create your own, choose 
Emulation Mode A from the Emulation menu, then Set All Controls to Emulation 
Mode A from the Actions menu. Now run Final Cut and open the Control Surfaces dia-
log from the Tools menu. Click on the “+” button to add a control surface and choose 
Mackie Control. Then choose FM 4/100 USB for the input connection and FM 4/100 
USB for the output connection. Click OK to exit the dialog.

FCP 5 requires the Audio Mixer (Tools Menu) to be open in order for control surface 
support to be active. You might want to save a window layout that has the Audio Mixer 
open.

FCP's control surface support will allow you to control audio volume, mutes and solos 
with the FM 4/100. If any volume changes are recorded into an audio track in FCP, the 
motorized FaderMaster fader corresponding to that track will follow those changes dur-
ing playback.

Please see the Final Cut manual for more information on using control surfaces.
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Logic Pro™
Logic Pro™ version 7 has built in support for the FM 4/100. To make use of it you first 
need a Logic keyset. You can import the one in /Applications/FM 4-100 USB 
Software/keysets or create one of your own using the FM 4/100 USB application's 
File > New Keyset… command. If you create a new keyset you need to choose Set All 
Controls to Native MIDI from the Actions menu.
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The first time you run Logic, go to Preferences > Control Surfaces > Setup. Choose 
Install… from the Setup Window's New menu. Click on JLCooper Fadermaster 4/
100 from the list of available control surfaces then click on the Scan button. Momentar-
ily the FM 4/100 should appear in the Setup Window. You can also manually add the 
JLCooper Fadermaster 4/100 to your setup by selecting it in the list, clicking on the 
Add button and choosing FM 4/100 USB for the Output and Input ports in the Setup 
Window.

From then on, you will be able to use the FM 4/100 with Logic as described in the con-
trol surface guide, which is included with Logic. In Logic's current implementation, bank 
selecting must be done with the mouse, by selecting a track in the bank you want to 
control with the FM 4/100.
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Nuendo™

Nuendo™ versions 5 through 7 have built in support for several MIDI control surfaces. 
Although the FaderMaster 4/100 is not one of the directly supported control surfaces, 
the FM 4/100 software's Emulation Mode A allows it to work with Final Cut.

The next time you run Nuendo, open the Device Setup dialog from the Devices menu 
then go click on Mackie Control under Remote Devices. Choose FM 4/100 USB for the 
MIDI Output and MIDI Input. Hit OK to accept your settings and close the Setup Dia-
log.

The Nuendo keyset assignments are identical to the assignments you get when you 
choose Set All Controls to Native MIDI from the Actions menu.

Feedback

Please send feedback to beta@jlcooper.com

©2002-2011 JLCooper Electronics
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